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1. Tehnoredactare academică 

Se recomandă utilizarea editorului de text Microsoft Word (MS Word), care permite fructificarea facilităților oferite 

de sistemul integrat de gestionare a referințelor [References]. 

Daca lucrați într-una din versiunile MS Word: 2013, 2016, 2019, Microsoft365 (parțial valabil și pentru versiunile 

mai vechi) și utilizați fișierul Template LicDisert, ignorați instrucțiunile scrise cu font albastru! 

1.1. Format general 

• Pagina A4 

• Marginile: 2 cm, excepție Left: 2,5 cm 

• Textul Normal: Times New Roman (TNR) 12, 1,5 lines, First line – 1,27 cm 

1.2. Titluri 

– titlul de nivel 1, numerotat cu o singură cifră (1. TITLU DE CAPITOL), cu majuscule 

T1: TNR 14; Bold; Centered; 1,5 lines 

– titlul de nivel 2, numerotat cu două cifre (1.1. Titlu de subcapitol) 

T2: TNR 13; Bold; Justified; 1,5 lines; alineat – 1,27 cm 

– titlul de nivel 3, numerotat cu trei cifre (1.1.1. Titlul diviziunii subcapitolului) 

T3: TNR 12; Bold; Justified; 1,5 lines; alineat – 1,27 cm 

Sunt exceptate de la numerotare următoarele titluri: Lista figurilor, Lista tabelelor, INTRODUCERE, CONCLUZII și 

BIBLIOGRAFIE/REFERINȚE. 

1.3. Text 

Textul va fi scris obligatoriu cu diacritice. 

Se vor evita spațiile libere între paragrafe sau înaintea lor; altfel spus – nu mai mult de un Enter. 

1.4. Paginare și listare 

Numerotarea paginilor se va face la subsol, centrat. 

Un exemplar din lucrare, în format fizic (listat), va fi pus la dispoziția comisiei de examen desemnate în momentul 

susținerii. 

Listarea lucrării se va face pe o singură parte a foii, dar poate fi acceptată și listare față/verso, cu excepția paginilor 

de la început (pagina-copertă, de titlu, cuprins, liste figuri/tabele). 

1.5. Cuprins 

Cuprinsul va fi plasat la începutul lucrării, imediat după pagina de titlu. 

Va conține toate titlurile, inclusiv cele care nu se numerotează. 

Dacă lucrarea conține figuri și/sau tabele, în cadrul CUPRINS-ului se vor regăsi și titlurile Lista figurilor și/sau Lista 

tabelelor 

1.6. Figuri și tabele 

Figurile (graficele/hărțile) și tabelele nu se vor dubla între ele prin prisma conținutului (Becker, 2019). 

De exemplu, dacă se include un grafic sau o hartă cu densitatea populației, nu se va mai reda același lucru în cadrul unui tabel, și 
invers. 

1.6.1. Figuri 

În categoria figurilor se încadrează: hărțile, graficele, imaginile (pozele) și schemele logice. 

Toate figurile vor avea un titlu, precedat de eticheta Fig., urmată de numărul figurii. 

Titlul, cu mărimea fontului mai redusă (11) și caractere italice, se plasează centrat, sub figură. 

Numerotarea figurilor se va face cu două numere arabe; primul va desemna numărul capitolului, iar cel de-al doilea 

– numărul efectiv al figurii din respectivul capitol. Se poate accepta totuși și 

varianta numerotării cu un singur număr (numere consecutive), care să indice 

a câta figură este în cadrul lucrării. 

Exemplu: Fig. 2.3. desemnează că figura aparține de capitolul 2 și este a 3-a figură 

din respectivul capitol. 

Dacă figura este preluată, sub titlu, pe următorul rând, se precizează sursa, 

sub forma citării narative. 

Dacă utilizăm propriile noastre imagini, sursa nu se menționează. 

Mărimea fontului pentru sursă ar putea fi redusă cu 1 punct [Font size: 10]. 
Fig. 2.3. Turism de croazieră 

Sursă: Nume (2011) 

https://blog.apastyle.org/apastyle/2019/05/the-relation-of-tables-and-figures-with-text.html
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Dacă imaginea este preluată de pe internet, precizarea sursei se va face prin trimitere la materialul de pe care este 

preluată. De exemplu, daca am prelua ceva de pe Go Hunedoara, precizarea sursei ar fi: Sursă: Go Hunedoara (2020) 

Unele imagini de pe internet ar putea fi protejate de drepturile de autor. Studentul, autorul lucrării, are datoria de a 

se asigura că prin utilizarea imaginii nu este încălcat dreptul de autor. 

Toate figurile vor fi citate în cadrul textului. 

Exemplu:  

Suspendisse lacinia accumsan nisi (Fig. 2.3). Donec at purus tellus. 

sau 

Suspendisse lacinia accumsan nisi (vezi Fig. 2.3). Donec at purus tellus. 

1.6.2. Tabele 

În această categorie se încadrează doar tabelele (elemente de redare a informației structurate pe linii și coloane). 

Este încurajată construcția unor tabele simple, fără linii verticale. 

Dacă se utilizează seturi de date provenind de la instituții, organisme, organizații etc., acest lucru trebuie precizat în 

lucrare, la partea în care se face referire la metodologie și datele pe care se bazează studiul. 

Adițional, pentru fiecare tabel în care sunt utilizate astfel de informații se va menționa sursa (cu caractere ceva mai 

reduse – 10 sau 11), sub tabel, în formatul citării narative. 

Exemplu: Sursă: Institutul Național de Statistică (2022) sau Sursă: Nume (2022) 

În funcție de complexitatea tabelelor, dimensiunea fontului poate fi diminuată, dar nu la o mărime mai mică de 8 

puncte. 

Toate tabelele vor avea un titlu, precedat de eticheta Tabel, urmat de numărul tabelului. 

Numerotarea se va face cu două numere arabe; primul va desemna numărul capitolului, iar cel de-al doilea – numărul 

efectiv al tabelului din respectivul capitol. Se poate accepta totuși și 

varianta numerotării cu un singur număr (numere consecutive), care 

să indice al câtelea tabel este în cadrul lucrării.  

Titlurile, cu mărimea fontului mai redusă (11) și caractere 

italice, se plasează deasupra tabelului. 

Dacă se impun precizări suplimentare legate de tabel, acestea pot 

fi făcute sub formă de Notă, sub tabel sau după sursă (dacă există), cu 

caractere ceva mai reduse (10 sau 11). 

Toate tabelele vor fi citate în cadrul textului. 

Exemplu:  

Suspendisse lacinia accumsan nisi, at pretium libero volutpat eget (Tabel 2.1). Donec at purus tellus. 

sau 

Suspendisse lacinia accumsan nisi, at pretium libero volutpat eget (vezi Tabel 2.1). Donec at purus tellus. 

La un tabel care se continuă pe pagina următoarea se va relua capul de tabel, iar deasupra lui se va face mențiunea 

Tabel [nr.] – continuare. Acest lucru este valabil și pentru eventualele tabele incluse la Anexe. 

Exemplu: Tabel 2.1 – continuare 

1.6.3. Adițional, despre figuri și tabele 

Dacă vom aduce modificări figurii (mai frecvent în cazul schemelor logice) sau tabelului preluat, la indicarea sursei 

se va menționa Adaptat după. [Exemplu – Sursă: Adaptat după Nume (2022)] 

1.7. Lista figurilor și lista tabelelor 

După CUPRINS, pe o pagină nouă se vor crea două liste separate, Lista figurilor – conținând titlurile figurilor și 

pagina la care se regăsesc și, o alta – Lista tabelelor, cu titlurile tabelelor și paginile corespondente; asemenea cuprinsului. 

Teoretic, cele două liste se realizează pe pagini separate, lucru valabil pentru cele ceva mai lungi, ceea ce este mai 

puțin probabil în cazul lucrărilor de licență/disertație. Dacă totuși numărul însumat al figurilor și tabelelor este mai mare 

de 25, cu condiția ca niciuna dintre ele să nu aibă mai puțin de cinci titluri, recomandarea este de a li se dedica pagini 

separate. 

1.8. Alte mențiuni 

1.8.1. Antete 

Sunt indicații plasate în partea superioară a paginii și sunt separate de textul propriu-zis al lucrării. 

În cadrul lucrărilor de acest tip (licențe, disertații), antetul este dat de numele capitolului, cu TNR 11, italic, centrat. 

Pagina pe care începe noul capitol nu conține antet. 

Din considerente ce țin de design-ul lucrării, antetele se subliniază pe întreaga oglindă a paginii. 

Antetele sunt facultative. 

Tabel 2.1. Indicele de utilizare netă a capacității de 

cazare turistică în funcțiune 

Categorii 

de confort 
2018 2019 2020 

5 stele 45,7 45,3 19,3 

4 stele 42,9 44,4 25,6 

3 stele 39,5 42,1 28,2 

Sursă: Institutul Național de Statistică (2022) 

Notă. Datele se referă doar la structurile de primire 
turistică de tip hotel și sunt exprimate în procente. 
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1.8.2. Anexe 

Nu sunt agreate mai mult de două figuri/tabele pe una și aceeași pagină. Dacă sunt considerate necesare, pot fi incluse 

la Anexe, după bibliografie/referințe.  

Anexele vor fi însoțite de un titlu, precedat de eticheta Anexa, se vor numerota separat de figurile și tabelele incluse 

în lucrarea propriu-zisă. Numerotarea se va face prin intermediul unui singur număr sau cu litere majuscule (Anexa 1. 

Titlu; Anexa 2. Titlu … / Anexa A. Titlu; Anexa B. Titlu …). Anexele pot conține și text (de exemplu, instrumentul de 

cercetare: chestionar sau ghid de interviu). Anexele vor fi indicate, citate în cadrul lucrării. 

1.8.3. Abrevieri 

Pot fi utilizate abrevierile consacrate (exemplu: mm, km, °C). Pentru cele care ar putea apărea mai puțin familiare, la 

prima apariție se va scrie denumirea completă, urmată, în paranteze rotunde, de abrevierea ce va fi utilizată ulterior. 

[exemplu: Institutul Național de Sănătate Publică (INSP)]. 

2. Citări, referințe și bibliografie 

2.1. Reguli generale 

Citările, bibliografia și/sau referințele se află într-o strânsă interdependență. Citarea reprezintă forma scurtă a 

referinței utilizată în text. Toate citările trebuie să aibă în mod obligatoriu o referință corespondentă în lista finală a 

surselor consultate, listă mai frecvent percepută ca bibliografie. 

Se va utiliza titlul REFERINȚE doar dacă sunt citate toate lucrările din listă. 

Se va utiliza titlul BIBLIOGRAFIE dacă în lista documentelor consultate există și materiale care nu au fost citate în lucrare. 

REFERINȚELE, ca titlu, conferă lucrării mai multă rigoare academică. 

Bibliografia se va baza pe minim 10 referințe din categoria cărților și/sau articolelor. 

Bibliografia sau referințele vor fi aranjate în ordinea alfabetică a primului autor (sau al autorului suplinit). 

Bibliografia sau referințele nu se numerotează. 

Citările și bibliografia se vor baza pe stilul APA. 

Este stilul adoptat de către American Psychological Association [APA] și normele sale sunt folosite în domeniile: 

științe sociale și comportamentale, medicină, științe naturale, științe umaniste și multe altele. 

Citările în stilul APA se realizează în așa-numitul sistem Autor-Dată (în cele mai multe cazuri, cu sensul de an), 

sistem utilizat și de stilul Harvard, de care este foarte apropiat. 

Citările în cadrul textului pot fi făcute în forma parantetică sau narativă.  

Citarea parantetică se referă la indicarea, fie în cadrul paragrafului, fie la sfârșitul acestuia, între paranteze rotunde 

a numelui autorului(-lor) și a anului – (Nume, 2022).  

Citarea narativă se referă la indicarea numelui autorului(-lor) în cadrul textului “povestit” de noi, urmat, între 

paranteze rotunde, doar de an – (2022). 

Titlurile, în general, ale cărților, ale articolelor etc., indiferent de modul în care sunt scrise în sursele primare, la 

referințe (bibliografie) se vor trece în format propoziție, adică doar prima literă a titlului majusculă, restul – minuscule, 

exceptând substantivele proprii, care, evident, vor fi scrise cu inițiala majusculă. Dacă titlul conține un subtitlu, delimitat 

prin două puncte [:], punct [.] sau caractere mai reduse, și acesta va fi scris în format propoziție. 

Titlurile revistelor academice se redau în forma denumirii oficiale; cuvintele cu inițiala majusculă se păstrează, 

respectiv nu se aplică regula formatului propoziție, menționat mai anterior. 

Cărțile și articolele care au codul DOI alocat se vor include în referințe. DOI-urile în formatele mai vechi vor fi 

actualizate la formatul curent, recomandat de Fundația Internațională DOI, de tipul: https://doi.org/xxxxx, unde 

https://doi.org/ reprezintă link-ul către xxxxx (codul DOI efectiv) (APA Style, 2022). 

La cărțile și articolele pentru care există DOI disponibil, referința se va finaliza fără punct (.). 

La sursele pentru care se impune menționarea URL-ului, referința se va finaliza fără punct (.). 

În editorul de text, la generarea referințelor, DOI-urile și URL-urile vor apărea inactive, însă, prin transformarea 

fișierului-text în format pdf, ele vor funcționa ca link-uri active (Lee, 2015). 

Pentru sursele care rămân arhivate pe site-uri (servere) nu se impune menționarea datei consultării lor. 

2.2. Exemple de citări și referințe 

2.2.1. Cărți 

A. Carte cu un singur autor 

În lista de referințe: 

Weed, M. (2008). Olympic tourism. Oxford1: Butterworth-Heinemann. 

Citare parantetică: (Weed, 2008) 

 
1 Menționăm totuși că ultimele recomandări ale APA Style nu reclamă necesitatea menționării locului de apariție a lucrării. 

Citare narativă: Weed (2008) 

https://blog.apastyle.org/apastyle/2015/04/should-links-be-live-in-apa-style.html
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B. Carte cu doi autori 

În lista de referințe (inclusiv DOI): 

Hevner, A., & Chatterjee, S. (2010). Design research in information systems. Theory and practice. New York: 

Springer. doi:https://doi.org/10.1007/978-1-4419-5653-8 

Citare parantetică: (Hevner & Chatterjee, 2010) Citare narativă: Hevner și Chatterjee (2010) 

C. Carte cu trei sau mai mulți autori 

În privința autorilor și a citărilor se procedează identic ca în cazul articolelor. 

D. Carte cu editor(i) 

În lista de referințe: 

Cresswell, T., & Merriman, P. (Ed.). (2011). Geographies of mobilities: Practices, spaces, subjects. Farnham: Ashgate. 

Citare parantetică: (Cresswell & Merriman, 2011) Citare narativă: Cresswell și Merriman (2011) 

E. Capitol sau articol dintr-o carte cu editor(i) 

În lista de referințe: 

Crang, M. (2011). Tourist: Moving places, becoming tourist, becoming ethnographer. În T. Cresswell, & P. 

Merriman (Ed.), Geographies of mobilities: Practices, spaces, subjects (pg. 205-224). Farnham: Ashgate. 

Citare parantetică: (Crang, 2011) Citare narativă: Crang (2011) 

2.2.2. Articole 

A. Articol cu un autor 

În lista de referințe: 

McKercher, B. (2016). Towards a taxonomy of tourism products. Tourism Management, 54, 196-208. 

doi:https://doi.org/10.1016/j.tourman.2015.11.008 

Citare parantetică: (McKercher, 2016) Citare narativă: McKercher (2016) 

B. Articol cu doi autori 

În lista de referințe: 

Quental, N., & Lourenco, J. M. (2012). References, authors, journals and scientific disciplines underlying the 

sustainable development literature: A citation analysis. Scientometrics, 90, 361-381. 

doi:https://doi.org/10.1007/s11192-011-0533-4 

Citare parantetică: (Quental & Lourenco, 2012) Citare narativă: Quental și Lourenco (2012) 

C. Articol cu trei-cinci autori 

În lista de referințe: 

Ritchie, B. W., Shipway, R., & Cleeve, B. (2009). Resident perceptions of mega-sporting events: A non-host city 

perspective of the 2012 London Olympic Games. Journal of Sport & Tourism, 14(2-3), 143-167. 

doi:https://doi.org/10.1080/14775080902965108 

Hughes, J. L., Brannan, D., Cannon, B., Camden, A. A., & Anthenien, A. M. (2017). Conquering APA style: Advice 

from APA style experts. Psi Chi Journal of Psychological Research, 22(3), 154-162. 

doi:https://doi.org/10.24839/2325-7342.JN22.3.154 

Citare parantetică: (Ritchie, Shipway, & Cleeve, 2009) 

(Hughes, Brannan, Cannon, Camden, & Anthenien, 2017) 

Teoretic, în cazul a trei-cinci autori, exemplul dat pentru citare parantetică este valabil pentru prima citare, iar ulterioarele 
(subsecvente) ar trebui să indice doar primul autor, urmat de și alții/et al., însă poate fi acceptată și utilizarea exclusivă a formei 
rezultate pentru prima citare. 

Citări parantetice subsecvente: (Ritchie, și alții, 2009) sau (Ritchie, et al., 2009) 

(Hughes, și alții, 2017) sau (Hughes, et al., 2017) 

Citare narativă: Ritchie, Shipway și Cleeve (2009) 

Hughes, Brannan, Cannon, Camden și Anthenien (2017) 

Citări narative subsecvente: Ritchie și alții (2009) sau Ritchie et al. (2009) 

Hughes și alții (2017) sau Hughes et al. (2017) 

Pentru o lucrare scrisă în limba română firească ar fi prima alternativă (și alții), dar având în vedere larga utilizare a celei de a 
doua (et al.) – poate fi acceptată și aceasta, cu condiția să păstrăm consecvența. 

D. Articol cu șase-șapte autori 

În lista de referințe: 

Sampson, N., Nassauer, J., Schulz, A., Hurd, K., Dorman, C., & Ligon, K. (2017). Landscape care of urban vacant 

properties and implications for health and safety: Lessons from photovoice. Health & Place, 46, 219–228. 

doi:https://doi.org/10.1016/j.healthplace.2017.05.017 

Hein, T., Schwarz, U., Habersack, H., Nichersu, I., Preiner, S., Willby, N., & Weigelhofer, G. (2016). Current status 

and restoration options for floodplains along the Danube River. Science of the Total Environment, 543, 778-

790. doi:https://doi.org/10.1016/j.scitotenv.2015.09.073 

Citare parantetică: (Sampson, și alții, 2017) sau (Sampson, et al., 2017) 

(Hein, și alții, 2016) sau (Hein, et al., 2016) 

Citare narativă: Sampson și alții (2017) sau Sampson et al. (2017) 

Hein și alții (2016) sau Hein et al. (2016) 
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E. Articol cu peste șapte autori 

În lista de referințe: 

Hall, C. M., Amelung, B., Cohen, S., Eijgelaar, E., Gössling, S., Higham, J., . . . Scott, D. (2015). On climate 

change skepticism and denial in tourism. Journal of Sustainable Tourism, 23(1), 4-25. 

doi:https://doi.org/10.1080/09669582.2014.953544 
În realitate sunt 10 autori. Se trec primii 6, se adaugă punctele de suspensie [...] și se încheie cu ultimul autor. 

Citare parantetică: (Hall, și alții, 2015) sau (Hall, et al., 2015) 

Citare narativă: Hall și alții (2015) sau Hall et al. (2015) 

Instrucțiunile mai recente ale APA referitoare la regula peste șapte autori au fost transformate în 21 sau mai mulți autori. Având 
în vedere că sistemul integrat al MS Word de gestionare a referințelor funcționează încă pe regula cu peste șapte autori, se va 
utiliza aceasta. 

F. Articole publicate în volumele conferințelor 

În lista de referințe: 

de Freitas Coelho, M., & Wada, E. (2019). Hospitality & stakeholders’ role change and capabilities in a cultural 

tourism destination. În Y. Ekinci, L. Sharples, G. Viglia, & D. Gursoy (Ed.), 9th advances in hospitality and 

tourism marketing and management conference [Conference] (pg. 56-65). Porthsmouth, UK: University of 

Portsmouth. Preluat de pe http://www.ahtmm.com/wp-content/uploads/2019/08/2019-AHTMM-Conference-

proceedings.pdf 

Citare parantetică: (de Freitas Coelho & Wada, 2019) Citare narativă: de Freitas Coelho și Wada (2019) 

2.2.3. Literatura gri 

În această categorie, în general sunt încadrate rapoartele, studiile sau documentele unor instituții sau organizații, la 

care, de cele mai multe ori, autorul lipsește, fiind atribuite instituției care le-a/pentru care s-au elaborat. În astfel de situații, 

locul autorului este suplinit de denumirea instituției scrisă integral. 

În lista de referințe: 

Ministerul Dezvoltării Regionale și Turismului. (2011). Ghidul stațiunilor balneare. București. Preluat de pe 

https://www.mdlpa.ro/userfiles/publicatii_ghid_statiuni_balneare.pdf 

Universitatea Babeș-Bolyai. (2019). Codul de etică și deontologie profesională al UBB. Cluj-Napoca. Preluat de pe 

https://www.ubbcluj.ro/ro/despre/organizare/files/etica/Codul-de-etica-si-deontologie-profesionala.pdf 

Citare parantetică: (Ministerul Dezvoltării Regionale și Turismului, 2011) 

(Universitatea Babeș-Bolyai, 2019) 

Citare narativă: Ministerul Dezvoltării Regionale și Turismului (2011) 

Universitatea Babeș-Bolyai (2019) 

2.2.4. Teze de doctorat 
În lista de referințe: 

Nume, P. (2016). Titlul propriu-zis al tezei de doctorat. Teză de doctorat. Preluat de pe https://rei.gov.ro/teze-

doctorat 

Nume, P. (2019). Titlul propriu-zis al tezei de doctorat. Rezumatul tezei de doctorat, Numele instituției. Preluat pe 

20.11.2019, de pe [adresa URL] 

Citare parantetică: (Nume, 2016) 

(Nume, 2019) 

Citare narativă: Nume (2016) 

Nume (2019) 

2.2.5. Seturi de date 
În lista de referințe: 

Institutul Național de Statistică. (2022). Tempo online. Preluat pe 13.01.2022, de pe 

http://statistici.insse.ro:8077/tempo-online/#/pages/tables/insse-table  

Citare parantetică: (Institutul Național de Statistică, 2022) Citare narativă: Institutul Național de Statistică (2022) 

Având în vedere actualizarea curent continuă a datelor, în cazul unor asemenea referințe se impune menționarea datei consultării site-ului. 
Dacă pentru una și aceeași lucrare s-au efectuat mai multe interogări ale bazei de date, ca dată a consultării se va reține cea a 
ultimei vizite. 

2.2.6. Pagini web și site-uri web 

În situația în care nu există ori nu găsiți cărți sau articole potrivite subiectului, se pot utiliza ca referințe și pagini ori 

site-uri web, dar ideal ar fi ca aceste materiale să aibă semnătura unui autor și o dată de apariție, astfel încât să poată fi 

atribuite cuiva. 

Simplele link-uri sunt inacceptabile! 

A. Blog 

În lista de referințe: 

Blumer, A. (2021, 26 noiembrie). Ivan, un altfel de campion [Blog post]. Preluat de pe https://www.eco-

romania.ro/noutati-blog/ivan-un-altfel-de-campion/ 

McAdoo, T. (2017, 20 septembrie). References versus citations [Blog post]. Preluat de pe 

https://blog.apastyle.org/apastyle/2017/09/references-versus-citations.html 

În loc de Blog post, de asemenea, se poate utiliza Postare blog. 
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Citare parantetică: (Blumer, 2021) 

(McAdoo, 2017)  

Citare narativă: Blumer (2021) 

McAdoo (2017) 

B. Material de pe un site cu autor, cu dată 

În lista de referințe: 

Cileacu, C. (2021, 28 august). Cum a devenit Transfăgărășanul o poveste de succes. Construit de armată, scopul 

inițial al drumului era cu totul altul. Preluat de pe Digi24: https://www.digi24.ro/stiri/externe/ue/cum-a-

devenit-transfagarasanul-o-poveste-de-succes-construit-de-armata-scopul-initial-al-drumului-era-cu-totul-

altul-1641619 

Citare parantetică: (Cileacu, 2021) Citare narativă: Cileacu (2021) 

C. Material de pe un site fără autor, cu dată 

Ideea de bază pentru redarea unei referințe puțin atipice, cum se întâmplă cel mai adesea cu informațiile multor site-uri, este 
aceea de a-i oferi cititorului/evaluatorului informații suficiente pentru a putea ajunge la sursa primară, dar în același timp este 
de avut în vedere și o formă rezonabilă pentru citarea referinței în text. În exemplele care urmează, opțiunea a fost de a susbtitui 
autorul cu numele site-ului. 
În lista de referințe: 

Evisiontourism. (2015, 25 mai). Turism de aventură: creștere preconizată și tendințe. Preluat de pe Evisiontourism: 

https://evisionturism.ro/turism-aventura-crestere-preconizata-tendinte/ 

Go Hunedoara. (2020, 15 ianuarie). Peste 400.000 de turiști au vizitat Castelul Corvinilor în 2019. Preluat de pe Go 

Hunedoara: https://www.gohunedoara.com/record-peste-400-000-de-turisti-au-vizitat-castelul-corvinilor-in-

2019/ 

Citare parantetică: (Evisiontourism, 2015) 

(Go Hunedoara, 2020) 

Citare narativă: Evisiontourism (2015) 

Go Hunedoara (2020) 

D. Material de pe un site fără autor, fără dată 

În lista de referințe: 

Eco-România. (n.d.). Delta Dunării. Preluat de pe Eco-România: https://www.eco-romania.ro/eco-destinatii/delta-

dunarii/ 

Eco-România. (n.d.). Despre ecoturism. Preluat de pe Eco-România: https://www.eco-romania.ro/ecoturism/despre-

ecoturism/ 
Dacă utilizăm informații de pe unul și același site, dar provenind din pagini diferite, îndeosebi când suntem nevoiți să le și cităm, 
pentru fiecare dintre pagini sunt necesare referințe distincte. 

Citare parantetică: (Eco-România, n.d.) 

(Eco-România, n.d.) 

Citare narativă: Eco-România (n.d.) 

Eco-România (n.d.) 

2.2.7. Hărți online 

Când harțile sunt tipărite, chiar și în variantele digitale 

(pdf, jpeg etc), alternativele de redare pot fi similare cu cele 

utilizate pentru cărți sau literatura gri, însă când apelăm la 

cele online (vezi McAdoo, 2015), cum ar fi, de exemplu 

Google Maps, redarea recomandată îndeosebi pentru lista 

de referințe (pentru că în text se va face citarea figurii) ar 

putea fi: 

Google. (n.d.). [Municipiul Cluj-Napoca]. Preluat pe 

25.01.2022, de pe https://tinyurl.com/2758vu72 

[cu URL scurtat] 

2.2.8. Acte normative 

Se au în vedere legi, hotărâri, ordonanțe, decrete etc. 

În lista de referințe: 

Lege nr. 290. (2018). Legea pentru modificarea și completarea Legii nr. 2/1968 privind organizarea administrativă 

a teritoriului României. Monitorul Oficial nr. 1052 din 12 decembrie 2018. 

Decret nr. 195. (2020). Decretul privind instituirea stării de urgență pe teritoriul României. Monitorul Oficial nr. 

212 din 16 martie 2020. 

Citare parantetică: (Lege nr. 290, 2018) 

(Decret nr. 195, 2020) 

Citare narativă: Legea nr. 290 (2018) 

Decretul nr. 195 (2020) 

2.2.9. Adițional, despre citări 

A. Autor cu mai multe lucrări din același an 

Când cităm unul și același autor cu mai multe lucrări, din același an, se impune adăugarea unui element distinctiv la 

an, fără spațiu (o literă, pornind cu începutul alfabetului).  

Citare parantetică: (Papathanassis, 2016a) și (Papathanassis, 2016b) 

Citare narativă: Papathanassis (2016a) și Papathanassis (2016b) 

Fig. 2.1. Municipiul Cluj-Napoca 
Sursă: Google (n.d.) 

https://blog.apastyle.org/apastyle/2015/08/how-to-cite-online-maps.html
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În mod similar se procedează și în cazul referințelor fără dată (mai frecvente pentru paginile diferite ale unuia și aceluiași 

site, la care nu este menționată data sau anul). [Vezi Material de pe un site fără autor, fără dată, pentru care dacă se fac citări 

trebuie să procedăm astfel: Eco-România (n.d.-a) și Eco-România (n.d.-b). Atenție, pentru no date (n.d.), elementul 

distinctiv este precedat de cratimă!] 

Dacă nu se fac citări, ci doar se trec la bibliografie, pentru situațiile exemplificate nu este nevoie de adăugarea 

elementelor distinctive. 

B. Mai mulți autori cu același nume (de familie) 

Dacă vom avea printre referințe lucrări la care există mai mulți autori cu același nume de familie autor principal sau 

unic, cum ar fi de exemplu: 

Hall, C. M., Amelung, B., Cohen, S., Eijgelaar, E., Gössling, S., Higham, J., . . . Scott, D. (2015). On climate change 

skepticism and denial in tourism. Journal of Sustainable Tourism, 23(1), 4-25. 

doi:https://doi.org/10.1080/09669582.2014.953544 

Hall, E. (2019). A critical geography of disability hate crime. Area, 51, 249-256. 

doi:https://doi.org/10.1111/area.12455 

Hall, T. (2015). Reframing photographic research methods in Human Geography: A long-term reflection. Journal 

of Geography in Higher Education, 39(3), 328-342. doi:https://doi.org/10.1080/03098265.2015.1038779 
citările parantetice vor fi: 

(Hall, și alții, 2015) sau (Hall, et al., 2015) – regula șase-șapte autori 

(Hall E. , 2019) – cu inițiala prenumelui, pentru a-l distinge pe Hall Edward de Hall Tim 

(Hall T. , 2015) – cu inițiala prenumelui, pentru a-l distinge pe Hall Tim de Hall Edward, 

iar cele narative: Hall și alții (2015), Hall E. (2019), respectiv: Hall T. (2015) 

2.3. Când și cum cităm? 

După ce am scris un text pentru care ne-am inspirat dintr-o carte, un articol etc., deontologia academică ne obligă să 

precizăm sursa pe care am utilizat-o pentru documentare, adică să o cităm. Textul nostru poate fi scris prin parafrazare 

sau citare directă (citate directe, preluare ad litteram). Citările se fac în mod diferit pentru fiecare dintre cele două situații. 

2.3.1. Citările pentru parafrazări 

Parafrazarea se referă la redarea ideilor unui text în propriile noastre cuvinte. 

Pentru o parafrazare corectă, consultă: Six Steps to Proper Citation Infographic!  

În cazul menționării în text a titlurilor de lucrări, ele se scriu respectând normele de scriere specifice fiecărei limbi; în engleză – 
toate cuvintele cu majusculă, mai puțin articolele, conjuncțiile, prepozițiile. Nu uita că pentru referințe/bibliografie se utilizează 
formatul propoziție!  

Parafrazarea este mult mai apreciată deoarece demonstrează că autorul lucrării a înțeles textul și îl poate reda într-o 

altă manieră. 

Citarea pentru o parafrază se poate face fie în varianta parantetică, fie în cea narativă. 

A. Exemple de citări parantetice 

Citare parantetică simplă 

Donec posuere blandit ex, sed elementum lacus commodo eget. Curabitur sodales, turpis eu cursus suscipit, justo 

felis posuere dolor, eget egestas dui ligula in purus. Donec porta felis non metus vehicula, a congue dui vulputate. 

Vivamus aliquet gravida ipsum ut dignissim (Weed, 2008). 

Citarea se poate face atât la sfârșitul paragrafului, cât și în interiorul lui. Dacă se citează la sfârșitul paragrafului, se intrepretează 
că întregul paragraf se bazează pe textul din lucrarea indicată. 

Sed tortor odio, consequat quis justo in, pretium finibus urna. Fusce vestibulum iaculis ornare (Weed, 2008). Integer 

scelerisque mattis ex finibus consectetur. Suspendisse id luctus neque. 

Citarea se face înainte de punct; punctul paragrafului sau al unei propoziții. 
sau  

Citare parantetică multiplă 

Nullam ultricies lorem ac ante ultricies lacinia. Subiectul a fost abordat de mai mulți specialiști (Hevner & Chatterjee, 

2010; Crang, 2011; Quental & Lourenco, 2012; McKercher, 2016), care au reliefat că vestibulum eleifend ipsum sed felis 

laoreet ullamcorper. Sed tempor lorem nec nibh tempus vulputate. 

Citarea parantetică multiplă se face prin menționarea referințelor în ordinea cronologică a apariției lor. 

B. Exemple de citări narative 

Un studiu realizat de Weed (2008) demonstrează că donec posuere blandit ex, sed elementum lacus commodo eget. 

Curabitur sodales, turpis eu cursus suscipit, justo felis posuere dolor, eget egestas dui ligula in purus. 
sau 

În studiile sale, Weed (2008; 2012) a evidențiat o interdependență ed tortor odio, consequat quis justo in, pretium 

finibus urna. Fusce vestibulum iaculis ornare. 
sau  

Subiectul a fost studiat de Papathanassis (2016a; 2016b). Autorul subliniază că egestas lorem urna, nec malesuada 

nulla sollicitudin sit amet. 

https://apastyle.apa.org/instructional-aids/six-steps-proper-citation.pdf
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sau 

În cercetările lor, Getz (2008), Ritchie, Shipway și Cleeve (2009) [la prima citare] și Weed (2012) au arătat fhasellus 

fringilla justo in massa blandit, at venenatis sapien pretium. 
și 

În cercetările lor, Getz (2008), Ritchie și alții (2009) [la citările subsecvente] și Weed (2012) au arătat fhasellus 

fringilla justo in massa blandit, at venenatis sapien pretium. 
sau 

Recentul cod adoptat de Universitatea Babeș-Bolyai (UBB) [și UBB pentru citările subsecvente] (2019) stabilește foarte 

clar că integer ligula risus, finibus non nibh ac, malesuada vulputate augue. 

Se mai întâlnesc situații când pentru introducerea unei citări narative se utilizează expresia “Conform lui McKercher (2016)…”. 
Este de evitat o asemenea alternativă, pentru a nu genera confuzii. În literatura științifică se utilizează cf., dar cu un sens sensibil 
diferit. Cf. abreviază latinescul confer care înseamnă comparație, a compara. O citare care apelează la cf. (cf. McKercher, 2016) 
sugerează invitația de a compara cu studiul către care se face trimitere. 

2.3.2. Citate directe 

Citatul direct desemnează textul preluat ad-litteram. 

A. Citate directe din documente cu paginile numerotate 

Citarea preluărilor directe poate fi făcută atât în varianta citării parantetice, cât și a celei narative. 

Pentru un text de până la 40 de cuvinte, citarea se face prin intermediul ghilimelelor, cu indicarea paginii la care poate 

fi găsit textul sursa citată. 

Exemplu – citare parantetică: 

„Pellentesque erat nunc, scelerisque vitae bibendum consequat, viverra vel nisi. Phasellus fringilla justo in massa 

blandit, at venenatis sapien pretium. Nullam ultricies lorem ac ante ultricies lacinia” (Sampson, și alții, 2017, p. 219). 
Exemplu – citare narativă: 

Integer elementum imperdiet lacinia, după cum argumentează Weed (2008, p. 19): „Sed porttitor ut nisl ultricies 

laoreet. Curabitur viverra aliquam augue”. 
sau 

Integer elementum imperdiet lacinia, după cum evidențiază Weed (2008): „Sed porttitor ut nisl ultricies laoreet. 

Curabitur viverra aliquam augue” (p. 19). 
Exemplu – citare parantetică: 

Pentru textele mai lungi, care depășesc 40 de cuvinte citarea se face în format bloc-text (un text care se diferențiază 

semnificativ de textul normal), fără a se mai utiliza ghilimelele din precedenta situație. 

Ut consectetur accumsan risus, vitae ornare arcu vehicula sit amet. Cras fringilla justo 

eget quam suscipit congue. Suspendisse potenti.Nam mollis, tortor a dignissim accumsan, 

ipsum nulla efficitur massa, sodales pharetra quam quam a eros. Duis porttitor, felis vitae 

ultricies consequat, risus est vulputate risus, non elementum erat ligula et tortor. Praesent nec 

posuere metus.  

Sed eu viverra ipsum. Ut porta, turpis vel volutpat aliquet, ante nisi tempus ipsum, nec 

dictum elit justo vitae ligula. Aliquam sit amet leo finibus, rhoncus lorem eu, fringilla turpis. 

Vivamus nec dolor non elit volutpat blandit et tincidunt lacus. Fusce congue nisi a molestie 

maximus (Hevner & Chatterjee, 2010, pg. 95-96). 
Pentru citările parantetice de la finalul bloc-textului, APA pledează totuși pentru preluarea în text inclusiv a punctuației finale și 
plasarea citării dupa aceasta, fără a se mai utiliza punctul după paranteză. Pentru exemplul de mai sus, bloc-textul s-ar încheia 
astfel: Fusce congue nisi a molestie maximus. (Hevner & Chatterjee, 2010, pg. 95-96) 

Din considerentele menționate, este acceptată și varianta respectivă. 

Exemplu – citare narativă: 

Nam dapibus felis sit amet lacus tempor, vitae interdum tellus sollicitudin, însă strategia reclamă multă muncă, admit 

McKercher și Prideaux (2014, p. 21): 

Praesent nec posuere metus. Sed eu viverra ipsum. Ut porta, turpis vel volutpat aliquet, 

ante nisi tempus ipsum, nec dictum elit justo vitae ligula. Aliquam sit amet leo finibus, rhoncus 

lorem eu, fringilla turpis. Fusce congue nisi a molestie maximus. Vivamus nec dolor non elit 

volutpat blandit et tincidunt lacus. Sed accumsan varius ornare. 

B. Citate directe din documente cu paginile nenumerotate 

Cel mai adesea, cu pagini nenumerotate ne întâlnim în cazul materialelor publicate pe site-urile web. Dacă se preia text 

pentru o citare directă, este necesară o indicare precisă a locului exact unde va putea fi regăsit citatul nostru. În această 

situație, se recomandă numărarea paragrafelor și menționarea numărului paragrafului din care s-a preluat ad-litteram. 

Exemplu – citare parantetică: 

După 100 de ani plutele de pe Bistrița au devenit o atracție inedită pentru turiștii dornici 

de adrenalină. La Ciocănești, Suceava, cu ocazia zilelor comunei, a fost organizată în luna 

august o săptămână a plutăritului. Numeroși turiști, dar și urmași ai plutașilor de odinioară au 

dorit să admire frumusețea locurilor chiar de pe apa Bistriței (Braic, 2021, p. par. 2). 
Teoretic, citarea corectă a paragrafului ar fi fost (Braic, 2021, par. 2), fără prescurtarea p., de la pagină, însă sistemul integrat al 
MS Word include din oficiu p. Se acceptă ambele variante. 
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Exemplu – citare narativă: 

Sed molestie, justo vel posuere eleifend. În 2021, Braic nota: 

După 100 de ani plutele de pe Bistrița au devenit o atracție inedită pentru turiștii dornici 

de adrenalină. La Ciocănești, Suceava, cu ocazia zilelor comunei, a fost organizată în luna 

august o săptămână a plutăritului. Numeroși turiști, dar și urmași ai plutașilor de odinioară au 

dorit să admire frumusețea locurilor chiar de pe apa Bistriței (p. par. 2). 

2.3.3. Surse secundare 

Este considerată o sursă secundară informația la care nu ați avut acces, dar ați aflat-o dintr-o altă carte, articol etc.  

Exemplu:  
Într-o lucrare [de exemplu, Weed (2008)] pe care o avem la dispoziție, găsim: 

Preuss (2005) identifică quisque eu efficitur neque. In nec magna quis sapien volutpat blandit. Cras eu nisi 

malesuada, ornare enim vitae, viverra purus. 

Am vrea să redăm ideea atribuită lui Preuss, dar nu găsim/nu avem acces la articolul lui (sursa primară). Putem 

proceda astfel: 

Sunt identificate quisque in nec sapien magna quis volutpat blandit eu efficitur neque. Malesuada cras eu nisi, ornare 

enim vitae, viverra purus (Preuss, 2005, citat de Weed, 2008). 

Sau, în loc de citat de, se poate utiliza și abrevierea apud (din latină), cu aceeași semnificație: (Preuss, 

2005, apud Weed, 2008) și menținem consecvența (ori citat de, ori apud – până la sfârșit). 

Ideal ar fi să nu fim nevoiți să utilizăm surse secundare, însă dacă totuși se întâmplă la referințe/bibliografie va fi 

trecută doar sursa la care am avut acces: Weed, în exemplul nostru, în timp ce Preuss nu va apărea. 

2.4. Cât citam? 

Greu de dat un răspuns îndeosebi în privința citatelor directe! 

O proporție însemnată a prezenței citatelor directe diminuează contribuția personală, iar pe de altă parte ar putea 

apărea riscul încălcării drepturilor de autor. În privința lucrărilor academice există totuși niște convenții care permit 

reproduceri de conținut, în anumite condiții, și anume: utilizarea să fie în scop educațional, citatul direct să fie de maxim 

400 cuvinte sau suma cuvintelor din mai multe citate directe să nu depășească 800 de cuvinte, cu condiția atribuirii corecte 

a citărilor (Institutul Tehnologic din Limerick, 2015; APA, 2021). În același scop, pot fi utilizate maxim trei figuri sau 

tabele dintr-un articol ori un capitol de carte. 

Un alt reper orientativ în privința cuantumului citatelor directe, de data asta din întreaga lucrare ar putea fi regula 

generală invocată de Institutul Tehnologic din Limerick (2015): „un proiect nu trebuie să conțină citate directe în proporție 

mai mare de 10%” (p. 18). 

3. Instrucțiuni pentru Template LicDisert 

Instrucțiunile pentru utilizarea fișierului Tempalte LicDisert sunt valabile pentru versiunile de Microsoft Word: 

2013, 2016, 2019, Microsoft365 și doar parțial pentru versiunile mai vechi. 

3.1. Introductive 

1. Personalizare primele două pagini (coperta și pagina de titlu). Le poți personaliza acum sau ulterior. 

2. Ignoră pagina Cuprins și cea cu listele figurilor și tabelelor, nu interveni asupra lor, le vei rezolva ulterior! 

3. Panou de navigare. Pentru comoditatea navigării în cadrul documentului, activează panoul de navigare: View → 

Navigation Pane ! Când nu mai ai nevoie de el – dezactivează-l: View → Navigation Pane ! 

4. Du-te la Introducere, din Navigation Pane! 

5. Scrie textul! 

6. Text pregătit. Dacă ai text pregătit deja în alte fișiere, îl poți transfera în fișierul template, dar ar fi bine să faci 

următoarele setări pe calculatorul tău: File → Options → Advanced → Cut, copy, and paste → și ce se vede în Fig. 

3.1 [chenar albastru]. 

7. Dacă vrei să lucrezi la această parte [Introducere] ulterior, poți să te apuci de unul dintre capitolele pentru care ai deja 

niște idei conturate. 

8. Capitol nou. Pregătește-ți o nouă pagină, făcând totodată și o secțiune nouă: Layout → Breaks → Section Breaks: Next 

Page. 

9. Titlu de capitol. Pe noua pagină scrie, cu majuscule, titlul și aplică-i stilul titlului de nivel 1 (vezi 3.2-1.). 

10. Titlu de subcapitol. Pe un rând nou, scrie titlul subcapitolului și aplică-i stilul titlului de nivel 2 (vezi 3.2-2.). 

11. Diviziune de subcapitol (“sub-subcapitol”). Pe un rând nou, scrie titlul pentru diviziunea subcapitolului și aplică-i stilul 

titlului de nivel 3 (vezi 3.2-3.). 
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12. Alt capitol. Indiferent dacă l-ai terminat sau nu pe precedentul, te poți apuca de oricare dintre cele pe care le ai în 

vedere. Pregătește-ți o pagină nouă, într-o secțiune nouă, în același mod: Layout → Breaks → Section Breaks: Next 

Page și o iei de la capăt cu titlul, textul, subcapitole și așa mai departe. 

13. Intercalare capitol. Pentru a intercala un capitol între alte două, creează-ți o pagină nouă, într-o secțiune nouă. Pentru 

crearea noii pagini, poziționează-ți cursorul după ultimul cuvânt al capitolului după care vrei să introduci un alt capitol: 

Layout → Breaks → Section Breaks: Next Page. 

14. Concluzii. Creează o pagină nouă ca și cum te-ai pregăti de un nou capitol. Scrie titlul CONCLUZII și aplică-i stilul 

titlului de nivel 1 (vezi 3.2.-1.). Titlul îți va apărea numerotat. Anulează numerotarea (vezi 3.2.-4.)! 

15. Bibliografie/Referințe. Creează o pagină nouă ca și cum te-ai pregăti de un nou capitol. Reamintește-ți diferența dintre 

bibliografie și referințe (vezi 2.1.). Scrie titlul adecvat și aplică-i stilul titlului de nivel 1 (vezi 3.2.-1.)! Titlul îți va 

apărea numerotat. Anulează numerotarea (vezi 3.2.-4.)! 

3.2. Titluri 

1. Titlului de nivel 1 aplică-i din Home → Styles → T1. 

2. Titlului de nivel 2 aplică-i din Home → Styles → T2. 

3. Titlului de nivel 3 aplică-i din Home → Styles → T3. 

4. Anularea numerotării titlurilor (INTRODUCERE, CONCLUZII, BIBLIOGRAFIE/REFERINȚE): Home → Numbering → 

None. 

3.3. Cuprins 

În Template LicDisert CUPRINS-ul este presetat (pregătit). Tot ce vom avea de făcut, va fi să-l actualizăm. După ce 

am introdus un nou titlu și am urmat instrucțiunile de la 3.2., mergem la pagina pe care se află CUPRINS-ul [în orice 

modalitate; pentru eficiență: View → Navigation Pane  și click pe CUPRINS din Navigation Pane] → click pe orice titlu 

dintre cele deja existente → click dreapta → Update Field → Update entire table ; altfel nu îți va actualiza decât 

paginile pentru titlurile existente în cadrul CUPRINS-ului.  

Aceeași procedură va fi urmată ori de câte ori vom dori să actualizăm CUPRINS-ul. 

3.4. Figuri și tabele 

A.  Figuri  

1. Dacă n-ai făcut setările recomandate în Fig. 3.1, o poți face acum, pentru cel puțin ultima opțiune: Insert/paste picture 

as: Square. Te va ajuta la gruparea titlului cu figură. 

2. Inserare figură pregătită: Insert → Pictures → du-te la dosarul în care ți-ai salvat figura → alege-o pe care dorești 

să o inserezi → OK. Dacă este cazul, redimensioneaz-o la dimensiunea potrivită. 

3. Titlu figurii [prima dată]: References → Insert Caption → Label: Figure; New Label [Fig.] →OK; Position: Below 

selected item (normal ar trebui să fie preselectată); Numbering → Include chapter number  → Use separator: . 

(period) → OK; OK. [Scrie titlul!] 

4. Titlul figurii [ulterior, cu condiția să nu fi intercalat și vreun tabel2 între timp]: References → Insert Caption → OK. 

[Scrie titlul!] 

5. Aranjarea titlului figurii: Home → Styles → T-Fig/Tab. În faza inițială, titlul va apare cu font roșu, tocmai să atragă 

atenția nevoii de a-l aranja (centrat și italic). 

6. Gruparea titlului cu figură: Selectează caseta-text (este suficient să dai un click pe titlu) + Ctrl → Selectează figura 

(click pe ea) → click dreapta → Group. 

 
2 Dacă ultimul Insert Caption a fost utilizat pentru un titlu de tabel, la generarea următorului titlu de figură este nevoie de schimbarea, la câmpul Label, 
a etichetei Tabel cu Fig.  

Fig. 3.1. Setări recomandate pentru menținerea formatărilor din șablon și pentru inserarea figurilor 
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7. Citarea figurii, între paranteze rotunde: References → Cross-references → Reference type [Fig.] → Only label and 

number → OK. 

B. Tabele  

1. Pentru a obține un tabel grupat cu titlul, inserează o casetă-text: Insert → Text Box → Draw Text Box. Cu mouse-ul 

fă un dreptunghi/un pătrat de dimensiunea aproximativă a tabelului. 

2. În caseta obținută, inserează tabelul: Insert → Table → selectează numărul de linii și coloane necesare. 

3. Titlul tabelului [prima dată]: Selectează întregul tabel → References → Insert Caption → Label: Table; New Label 

[Tabel] → OK; Position: Above selected item (normal ar trebui să fie preselectată); Numbering → Include chapter 

number  → Use separator: . (period) → OK; OK. [Scrie titlul!] 

4. Titlul tabelului [ulterior, cu condiția să nu fi intercalat și vreo figură3 între timp]: References → Insert Caption → OK. 

[Scrie titlul!] 

5. Redimensionează caseta-text la mărimea potrivită. Îngroap-o în text: Layout Options → Square sau click dreapta → 

Wrap Text → Square. 

6. Poziționează-ți tabelul în locul potrivit, prin intermediul casetei-text, mutând-o cu mouse-ul sau prin intermediul 

săgeților din tastatură. 

7. Citarea tabelului, între paranteze rotunde: References → Cross-references → Reference type [Tabel] → Only label 

and number → OK. 

C. Adițional, despre figuri și tabele 

Numerotarea figurilor se realizează automat în funcție de poziție (locul în cadrul capitolului) și capitol. 

Dacă se mai inserează vreo figură sau vreun tabel în fața celor existente, citările figurilor și tabelelor (vezi punctul 7, 

la ambele) nu se actualizează automat. 

Adițional. De exemplu, la capitolul 2 avem două figuri deja inserate – fig. 2.1 și fig. 2.2, cu citările corespondente: (Fig. 2.1) și 

(Fig. 2.2). Dacă ne decidem să mai includem o figură în fața acestora, noii figuri îi va fi alocată eticheta fig. 2.1, în timp ce 

următoarele vor deveni fig. 2.2 și fig. 2.3, însă citările nu se vor actualiza, respectiv vor rămâne: (Fig. 2.1) și (Fig. 2.2). 

Actualizarea se poate face succesiv, individual; click pe citare (Fig. 2.1) [în interiorul parantezei] → click-dreapta 

→ Update Field și așa mai departe. Mai simplu, se poate selecta întregul capitol: click-dreapta [oriunde] → Update Field 

se vor actualiza toate citările, atât ale figurilor, cât și ale tabelelor.  

Este de evitat plasarea a mai mult de două elemente din această categorie (două figuri, două tabele sau mixt: o figură și 

un tabel) pe una și aceeași pagină! 

Dacă introduceți grafice (diagrame), recomandarea este să le construiți în cadrul fișierului în care lucrați (în Word, 

chiar dacă pregătirea datelor o faceți în Excel, de exemplu). [Insert → Chart; alegeți șablonul dorit, iar ulterior îl aranjați 

cum considerați că este necesar.] 

3.5. Generare liste figuri/tabele 

1. După ce ai finalizat o figură/un tabel, du-te la pagina de după CUPRINS sau activează panoul de navigare: View → 

Navigation Pane  și click pe Lista figurilor/tabelelor! 

2. Lista figurilor. Selectează cuvântul Generează (dublu click) → References → Insert Table of Figures → Caption 

Label: alege Fig. → OK. 

3. Lista tabelelor. Selectează cuvântul Generează (dublu click) → References → Insert Table of Figures → Caption 

Label: alege Tabel → OK. 

4. Actualizare lista figurilor (tabelelor). Ulterior, când mai introduci vreo figură (tabel)/mai multe/toate, selectezi un titlu 

din Lista figurilor (tabelelor) și fie apeși tasta F9, fie click dreapta → Update Field → Update entire table ; altfel 

nu îți va actualiza decât paginile pentru figurile/tabelele existente în listă. 

5. Dacă lucrarea nu conține figuri/tabele, la final șterge Lista figurilor/Lista tabelelor, de după CUPRINS! 

3.6. Citări electronice – “tips & tricks” academic 

Prin citări electronice vom înțelege citările făcute prin intermediul sistemului integrat al MS Word de gestionare a 

referințelor. 

3.6.1. Pregătirea referinței pentru citare 

După ce am scris textul pentru care avem obligația de a cita, ne folosim de facilitățile sistemului integrat al Word-

ului de gestionare a referințelor (Fig. 3.2): References –> Manage Sources → New și completăm câmpurile ferestrei 

Create Source, nu înainte de a alege tipul de sursa (Type of Source) pentru care vom completa informațiile pentru referință. 

Pentru completarea câmpului Author, recomandăm opțiunea Edit din dreapta câmpului și completarea autorului(-ilor) 

în fereastra Edit Name. După fiecare autor introdus – click pe Add. Când ați terminat cu toți autorii – OK. Îi veți regăsi în 

câmpul Author. 

 
3 Dacă ultimul Insert Caption a fost utilizat pentru un titlu de figură, la generarea următorului titlu de tabel este nevoie de schimbarea, la câmpul Label, 
a etichetei Fig. cu Tabel.  
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După ce se validează fereastra Create Source (OK), obținem referința disponibilă (Fig. 3.3) pentru documentul în 

care am creat-o – în Current List, dar, totodată, se și stochează pe calculatorul nostru – în Master List, pentru a o putea 

utiliza ulterior pentru alte lucrări (proiecte, licență, disertație, doctorat etc.). 

Simultan, în Preview-ul din stânga jos a figurii amintite, este afișată modalitatea de citare și cea a modului în care 

va apare ca referință la bibliografie. 

În cazul încă a majorității cărților este suficientă completarea doar a câmpurilor ferestrei Create Source (vezi Fig. 

3.2), însă la cele mai recent apărute se impune completarea unor informații suplimentare (DOI), iar la articole, pe lângă 

DOI, obligatoriu de menționat când este alocat, se mai impune precizarea volumului (Volume) și a numărului revistei 

(Issue). Pentru a putea fi completate și aceste informații, trebuie să extindem fereastra Create Source, bifând opțiunea 

Show All Bibliography Fields, iar ulterior să completăm câmpurile necesare. 

Pentru a ști care sunt câmpurile ce trebuie completate pentru o sursă sau alta, inițial trebuie să stabiliți tipul de sursă. 

Exemplele de la punctul 2.2. ale acestui ghid vă vor ajuta să încadrați lucrarea într-o anumită categorie. 

Fig. 3.2. Crearea unei noi referințe pentru o carte cu sistemul integrat de gestionare a surselor al MS Word 

Fig. 3.3. Referința rezultată 
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Să presupunem că aveți la dispoziție un articol cu trei autori, asta însemnă că se potrivește cu exemplul furnizat 

pentru Ritchie, B. W., Shipway, R., & Cleeve, B. (2009). Deschideți documentul (Fig. 3.4) Identificator tip referinta → 

References → Manage Sources → selectați în Current List referința pe care doriți să o consultați → Edit → în fereastra 

Edit Source treceți în revistă câmpurile completate, iar ulterior creați propria voastră referință pentru un document similar. 

În această fază, drept bonus, puteți copia toate sursele din Current List-ul anexei (fișierului) Identificator tip referinta 

pe propriul vostru calculator. Pentru aceasta, selectați-le pe toate și <-Copy. Acest demers vă va scuti ulterior de 

necesitatea deschiderii unui document adițional [Identificator tip referinta], consultarea câmpurilor necesar a fi 

completate fiind posibilă prin editarea sursei de pe calculatorul personal [References → Manage Sources → selectați în 

Master List referința pe care doriți să o consultați → Edit → în fereastra Edit Source treceți în revistă câmpurile 

completate]. 

Sursa, odată creată, poate fi citată electronic în cadrul textului atât în varianta parantetică, cât și narativă. 

3.6.2. Citări parantetice 

Citările parantetice pot fi simple sau multiple. Vezi Exemple de citări parantetice! 

A. Citare parantetică simplă 

Alegem locul în care ne propune să facem citarea și din References → Insert Citation → alegem sursa pe care o 

dorim → click. [Exemplu rezultat: (Weed, 2012)] 

B. Citare parantetică multiplă 

Citare multiplă: includerea într-o singură paranteză a mai multor lucrări consultate. 

Plecăm de la o citare simplă pentru prima lucrare în ordine cronologică. 

Pentru a obține o citare multiplă, este nevoie de accesarea primei citări (click oriunde în interiorul parantezei), iar 

ulterior adăugăm succesiv celelalte lucrări. 

Exemplu rezultat: (Hevner & Chatterjee, 2010; Crang, 2011; Quental & Lourenco, 2012; McKercher, 2016) 

3.6.3. Citări narative 

A. Citare narativă simplă 

Pregătim textul pentru o citare 

narativă. 

Introducem o citare parantetică 

simplă. O accesăm pe aceasta (click 

oriunde în interiorul parantezei). Vom 

avea acces la Citation Options (Fig. 

3.5); edităm citarea și suprimăm 

autorul (și titlul4). 

Exemplu rezultat: Un studiu realizat de Stone (2012) demonstrează că ... 

 
4 Teoretic ar fi fost necesară doar suprimarea autorului, însă sistemul integrat de gestionare a a referințelor, probabil pentru avertizare, în locul autorului 
include titlul, motiv pentru care sunt de bifat ambele opțiuni. 

Fig. 3.5. Editare citare și suprimare autor 

 

Fig. 3.4. Consultarea anexei documentului Identificator tip referinta, pentru identificarea informațiilor reclamate pentru crearea 

unei referințe similare 
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B. Citare narativă multiplă 

Citare multiplă pentru același autor cu mai multe lucrări, din ani diferiți 

Pregătim textul pentru o citare narativă. 

Plecăm de la o citare simplă pentru prima lucrare în ordine cronologică. O accesăm pe aceasta (click oriunde în 

interiorul parantezei), iar ulterior adăugăm cealaltă/celelalte. 

Urmând exemplul din fig. 3.6, edităm prima lucrare (2008) – suprimăm autorul și titlul (Fig. 3.5); edităm cea de a 

doua lucrare (2012) și suprimăm autorul și titlul. Obținem citarea din exemplul de mai jos: 

În studiile sale, Weed (2008; 2012) a evidențiat o interdependență... 

Citare multiplă (dublă) pentru același autor cu mai multe lucrări, din același an 

Exemplu: Subiectul a fost studiat de Papathanassis (2016a; 2016b). Autorul subliniază că egestas lorem urna... 

Până când obținem doar citarea anilor, procedăm ca în exemplul anterior (Fig. 3.6), după care edităm succesiv sursele 

(Fig. 3.8.) și adăugăm un element distinctiv (Fig. 3.7) la an, fără spațiu (o literă, pornind cu începutul alfabetului). 

Foarte important! În momentul în care confirmăm cu OK, vom fi avertizați că sursa bibliografică există în 

ambele liste: Master List (pe calculator) și în Current List (fișierul în care lucrăm). Se actualizează doar Current List, în 

consecință vom alege No, deoarece nu avem de unde să știm dacă, pentru nevoile noastre ulterioare, vom avea nevoie de 

ambele lucrări. 

În mod identic se procedează și în cazul citărilor parantetice simple atunci când ambele referințe sunt citate, dar în locuri diferite. 

3.6.4. Citate directe 

În cazul utilizării citatelor directe, menționarea paginii se face în câmpul destinat al ferestrei Edit Citation (Fig. 3.5). 

La redarea citatelor directe, ținem cont de regula celor 40 de cuvinte. 

Pentru a afla numărul cuvintelor din citat, selectați textul și utilizați combinația de taste: Ctrl + Shift + G sau, cu 

textul selectat, aruncăm o privire peste bara de stare (linia de jos cu informații adiționale), în stânga documentului. 

Pentru formatul bloc-text, selectați textul sau pur și simplu plasați cursorul pe text și aplicați-i stilul Citat, din Home 

→ Styles → Citat. 

Fig. 3.6. Citare narativă dublă pentru același autor 

Fig. 3.7. Adăugarea unui element distinctiv pentru lucrările aceluiași autor, din același an (Vezi următorul paragraf!) 

Fig. 3.8. Citarea lucrărilor aceluiași autor(i) din același an 
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3.7. Generarea referințelor sau a bibliografiei 

Cu toate referințele create (pe care le avem în Current List-ul documentului) și citate, din References → Bibliography 

→ Insert Bibliography vom obține REFERINȚE. 

Dacă în Current List am introdus și alte surse care totuși nu au fost citate, din References → Bibliography → Insert 

Bibliography vom obține BIBLIOGRAFIE. 

3.8. DOI și URL scurte 

O recentă recomandare a APA, care totuși a stârnit anumite controverse (McAdoo, 2019), este de a scurta în anumite 

cazuri, când sunt mai complexe (mai lungi) DOI-ul sau URL-ul. 

Pentru scurtarea DOI-ului este recomandat serviciul Fundației Internaționale DOI, ce poate fi accesat la 

http://shortdoi.org/ 

Pentru scurtarea URL-ului, în materialul lui McAdoo (2019) sunt amintite serviciile furnizate de Bitly 

(https://bitly.com/) sau Perma.cc (https://perma.cc/). Se poate testa cu succes și TinyURL (https://tinyurl.com/app/). 

DOI. În cazul DOI-urilor sunt mai rare cazurile când s-ar impune scurtarea lor, pentru că ele în general nu sunt lungi, 

dar nu sunt excluse situațiile când ar putea ameliora forma de redare a referinței. 

Exemplu: 

Hall, E. (2019). A critical geography of disability hate crime. Area, 51, 249-256. 

doi:https://doi.org/10.1111/area.12455 

Hall, E. (2019). A critical geography of disability hate crime. Area, 51, 249-256. doi:https://doi.org/jx9g 

 

URL. Recomandarea pentru scurtarea URL-ului, în cazul unuia complex (lung), este doar pentru situațiile care pot 

conduce la o ameliorare evidentă a aranjării în pagină a referinței. 
Exemplu: 

Institutul Național de Statistică. (2017). Proiectarea populației în profil teritorial la orizontul anului 2060. București. 

Preluat de pe 

http://www.insse.ro/cms/sites/default/files/field/publicatii/proiectarea_populatiei_romaniei_in_profil_teritoria

l_la_orizontul_2060.pdf 

Institutul Național de Statistică. (2017). Proiectarea populației în profil teritorial la orizontul anului 2060. București. 

Preluat de pe https://tinyurl.com/ejj7hnrp 

3.9. Antete 

Când vei scrie mai mult de o pagină, fie la INTRODUCERE, fie la oricare dintre capitole, îți va apare antetul Antet, subliniat. 

Pentru modificarea antetului Antet, pe care îl avem deja, este nevoie să dezactivăm legăturilor dintre secțiuni. 

Dezactivarea legăturilor dintre secțiuni. Du-te pe o pagină pe care apare antetul și fie dublu click în partea superioară 

a paginii (unde e antetul), fie: Insert → Header → Edit Header. În felul acesta vei accesa spațiul dedicat antetului/-lor 

(Header). Pentru întreruperea/dezactivarea legăturii: Link to Previuos (trebuie să-ți dispară eticheta Same as Previous din 

dreapta-sus a paginii). 

Înlocuiește antetul existent cu cel dorit (de exemplu: Cadrul geografic general)! 

La următorul capitol, te vei întâlni cu noul antet Cadrul geografic general. Pentru modificarea lui este nevoie de 

urmat aceeași procedură (Dezactivarea legăturilor dintre secțiuni și, ulterior, modificare). 

Dacă textul de la INTRODUCEREA noastră va trece și pe următoarea pagină (și ar fi bine să se întâmple, dar nu în mod obligatoriu), și 

în această situație vom observa deasupra celei de a doua pagini Antet. La acesta nu va fi vizibilă legătura activă cu secțiunile din 

față (nu vom vedea eticheta Same as Previous, dacă vom accesa spațiul dedicat antetului); Antet poate fi înlocuit cu Introducere, 
fără niciun fel de alte preparative. 

Dacă te decizi totuși să renunți la antete, accesează spațiul destinat acestora, selectează, cu dublu click (important 

dublu click), cuvântul Antet și Delete. 

3.10. Actualizare generală 

La finalizarea lucrării, 

însă acest lucru este posibil și 

pe parcursul elaborării ei, se 

pot actualiza rapid 

concomitent CUPRINS-ul, 

Lista figurilor, Lista tabelelor, 

citările figurilor, citările 

tabelelor și BIBLIOGRAFIA 

/REFERINȚE, în felul următor: 

Ctrl+A (se selectează toată 

lucrarea), fie F9, fie → click Fig. 3.9. Actualizare generală (cuprins, figuri, tabele, bibliografie) 

http://shortdoi.org/
https://bitly.com/
https://perma.cc/
https://tinyurl.com/app/
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dreapta → Update Field → Update entire table  [de trei ori – pentru Cuprins, figuri și tabele, dar și bibliografie; dacă nu avem 

figuri sau tabele – Update entire table - doar de două ori]. De fapt, o fereastra similară cu cea din din fig. 3.9, va reapărea de câte ori va fi nevoie; 

totul este bifăm cea de a doua opțiune Update entire table. 
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Anexă 

Declarație pe proprie răspundere 

Declarația va fi inclusă la finele lucrării. 

Se va genera o secțiune nouă, după BIBLIOGRAFIE/REFERINȚE (sau după ANEXE, dacă există). 

Pagina dedicată declarației nu va fi numerotată. 

[Insert → Footer → Edit Footer → Link to Previous → Delete numărul paginii] 
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